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Quantitative ELISA
Experiment Objective:

In this experiment, students will master the concepts and methodology 
behind the quantitative enzyme-linked immunosorbent assay (ELISA). 
Students will perform an ELISA to detect the concentration of two different 
antigens. A standard curve will be created for each antigen to allow for 
accurate quantification in unknown samples.

See page 3 for storage instructions.
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Experiment Components

COMPONENTS		  Check (√)
Store components A-I in the refrigerator.

A	 Antigen A		  q
B	 Antigen B		  q
C	 Dilution Buffer		  q
D	 Primary Antibody A		  q
E	 Primary Antibody B		  q
F	 10x Wash Buffer		  q
G	 Secondary Antibody		  q 
H	 ABTS		  q
I	 Stop Solution		  q

REAGENTS & SUPPLIES		  Check (√ )
Store all components below at room temperature.

•	 Microtiter plates		  q
•	 Transfer pipets		  q
•	 Snap-top microcentrifuge tubes		  q
•	 5 mL tubes		  q
•	 15 mL conical tubes		  q
•	 50 mL conical tube		  q

Experiment #278 is 
designed for 10 lab 
groups. 

• 	 Distilled or deionized water
• 	 Beakers (small, 100-150 mL recommended)
• 	 Disposable lab gloves
• 	 Safety goggles
• 	 Automatic micropipettes and tips (5-50 µL for students, 200-1000 µL for teacher prep)
•	 Paper towels

All experiment components 
are intended for educational 
research only.  They are not 
to be used for diagnostic or 
drug purposes, nor admin-
istered to or consumed by 
humans or animals.

Requirements  (not included with this kit)

None of the components have been prepared from human sources.

QUANTITATIVE ELISAEDVO-Kit 278
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Organisms are incredibly complex, consisting of an elaborate mixture of proteins, carbohydrates, and nucleic acids. 
In addition, different organisms, and even different cells within an organism, can contain an entirely distinct mix-
ture of these compounds. Because of this, examining the function of one specific protein can become extremely 
challenging. 

Fortunately, scientists have developed tools to measure the presence, and in certain cases the concentration, of a 
desired protein in a complicated mixture. One of the most common of these is the Enzyme-Linked ImmunoSorbent 
Assay, or ELISA. The ELISA uses antibodies to determine if a specific protein is present in a sample. ELISAs are com-
monly performed to test patient samples, monitor environmental specimens, and to ensure food and drug safety. 

An ELISA can be designed to provide qualitative or quantitative results. In a qualitative ELISA, the results will indi-
cate if a sample is positive or negative for the target. This type of assay is simple to perform and is useful for situ-
ations where the exact concentration of molecules is not necessary, such as pregnancy or drug tests. Alternatively, 
quantitative ELISAs use a standard curve to determine the precise concentration of a substance in the sample. Be-
cause of this, quantitative ELISAs reveal more information about the sample, although they are also more complex 
and take longer to perform.

ANTIBODIES – THE FOUNDATION OF THE ELISA

The most important components in any ELISA are the specific 
antibodies that will be used to detect the target protein. Antibod-
ies are specialized proteins consisting of four linked polypeptide 
chains: two identical “heavy chains” and two identical “light 
chains” that form a “Y” shaped molecule (Figure 1). The primary 
function of antibodies is to allow the immune system to distin-
guish between “self” and “non-self” proteins or polysaccharides. 
Every antibody will selectively bind to a unique target, known as 
an antigen, using sites at the ends of the short arms of the “Y”. 
The amino acid sequence in this region is variable, allowing for 
each antibody to recognize a unique epitope (a particular location 
within an antigen). 

To create the antibodies used in scientific research, scientists inject animals (i.e. rabbits, goats, and guinea pigs) 
with the antigen of interest. In response to the injection, the animal’s immune cells create antibodies that recog-
nize different epitopes of the antigen. Blood is recovered from the immunized animal and the antibody-containing 
serum is separated from the blood cells. 

Because of their specificity, researchers can use antibodies to detect the presence of specific biomolecules (i.e. 
peptides, proteins, antigens and hormones) in a complex sample. Most ELISAs use a combination of two antibod-
ies. First, a primary antibody is selected to detect the target protein. These antibodies are very specific and are 

Background Information

Figure 1:  
General Structure of an antibody.
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designed to only bind to a single protein. Next, a secondary antibody is chosen to target the primary antibody. 
For example, if the primary antibody is made from rabbit immune cells, a secondary antibody will be selected to 
identify rabbit proteins. 

In addition to targeting the primary antibody, the secondary antibody is also covalently linked to a Horseradish Per-
oxidase (HRP) enzyme. This enzyme can oxidize certain substrates to produce a visible color change, which is used 
to indicate the presence of our target protein. For example, HRP can react with the substrate ABTS ((2,2′-Azino-bis 
(3-ethylbenzothiazoline-6-sulfonic acid)). In the presence of hydrogen peroxide, the HRP enzyme will oxidize ABTS, 
turning the clear solution a vivid blue-green. HRP has a high catalytic activity – the substrate turnover rates exceed 
106 per second – allowing us to quickly detect even the smallest amount of antigen present within the sample. 

THE ELISA PROCEDURE

In the laboratory, ELISAs are performed in transparent plastic microtiter plates. Scientists add the test samples and 
controls to the wells of the plastic plate, where they non-specifically stick to the wells through hydrophobic and 
electrostatic interactions (Figure 2). This means that any protein in the sample, and not just the desired target, can 
stick to the plastic. Next, the primary antibody is added to the wells, and the mixture is allowed to incubate for a 
short time. This antibody specifically recognizes and binds to the target molecule (Figure 2). Therefore, if any target 
protein is present in the microtiter wells it will be recognized by the primary antibody. 

Following a brief incubation period, the wells are washed to remove any primary antibody that did not bind with 
the antigen. After the wash, an HRP-linked secondary antibody is added to the wells where it recognizes and binds 
to the primary antibody (Figure 2). The excess secondary antibody is removed from the wells by washing several 
times with buffer. However, if the secondary antibody has bound to the primary antibody it will stay in the well. 

Finally, a substrate solution of ABTS and hydrogen peroxide is added to each well. The HRP enzyme linked to the 

Figure 2:  Optimized ELISA workflow
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secondary antibody can oxidize ABTS in wells where the antigen-antibody complex is present, turning the clear 
substrate solution blue-green. 

Importantly, the enzyme-substrate reaction can only occur if every step of the ELISA was successful. If the target 
protein is not present in the sample solution, or if the concentration is too low, the primary and secondary antibod-
ies will not have anything to bind to and will be washed out of the well. Similarly, even if the antigen is present 
it will not be detected if the wrong primary antibody is used. In each of these scenarios, there will be no HRP 
enzyme available and the ABTS substrate will remain colorless.

During a quantitative ELISA, some of the wells will contain solutions where the concentration of antigen is already 
known. These samples are commonly created by diluting the antigen to create a standard curve that contains a 
broad range of antigen concentrations. The intensity of substrate in the unknown samples can then be compared 
to the standard curve to determine an approximate antigen concentration.

In this experiment you will perform an ELISA to examine two different antigens in experimental samples. Primary 
Antibody 1 will only detect antigen A, while Primary Antibody 2 is specific for antigen B. Both primary antibodies 
can be detected by the same secondary antibody. Standard curves will be created for each pair of antigens and 
antibodies to allow for accurate quantification of the proteins. Finally, the specificity of the ELISA will be examined 
by swapping the antigen-antibody pairs.
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EXPERIMENT OBJECTIVE:  

In this experiment, students will master the concepts and methodology behind the quantitative enzyme-
linked immunosorbent assay (ELISA). Students will perform an ELISA to detect the concentration of two 
different antigens. A standard curve will be created for each antigen to allow for accurate quantification in 
unknown samples.

LABORATORY SAFETY

1.	 Gloves and goggles should be worn routinely as good laboratory practice.

2.	 DO NOT MOUTH PIPET REAGENTS - USE PIPET PUMPS OR BULBS.

3.	 Always wash hands thoroughly with soap and water after handling contaminated 
materials. 

LABORATORY NOTEBOOKS:

Address and record the following in your laboratory notebook or on a separate worksheet.

Before starting the Experiment:

•	 Carefully read the introduction and the protocol. Use this information to form a hypothesis for this experi-
ment. 

•	 Predict the results of your experiment.  

During the Experiment: 

• 	 Record (draw) your observations, or photograph the results.

After the Experiment:

• 	 Formulate an explanation from the results.
• 	 Determine what could be changed in the experiment if the experiment were repeated.
• 	 Write a hypothesis that would reflect this change.

Experiment Overview

Wear gloves 
and safety goggles

QUANTITATIVE ELISAEDVO-Kit 278
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Module I: Performing a Quantitative ELISA

CREATING THE PROTEIN STANDARD DILUTIONS

1.	 OBTAIN tubes of concentrated Antigen A (A1) and Antigen B (B1), empty snap-top microcentrifuge tubes, and 
a tube of Dilution Buffer.

2.	 LABEL 5 tubes as A2-A6 for Antigen A, and a second set of tubes as B2-B6 for Antigen B.
3.	 Using a micropipette, ADD 150 µL of Dilution Buffer to each of the labeled microcentrifuge tubes from step 2.
4.	 TRANSFER 50 µL of antigen from tube A1 into tube A2. 
5.	 Fully MIX the sample by pipetting up and down 5 times.
6.	 Using the same pipette tip, TRANSFER 50 µL from tube A2 into tube A3 and mix as in step 5.
7.	 Continue to serially DILUTE the remaining samples through tube A6.
8.	 REPEAT steps 4-7 to create serial dilutions of Antigen B.

1. 150 µL to each tube

A1

Dilution
Buffer

Dilution
Buffer

B1

2.

A2
A3

A4
A5

A6

B2
B3

B4
B5

B6

3.

A2
A3

A4
A5

A6

B2
B3

B4
B5

B6

50 µL4.

A1 A2

5.

A2

MIX

A3

MIX

50 µL6. 7.

A3A2

8. REPEAT FOR ANTIGEN B.CONTINUE THRU A6.

50 µL 50 µL

A3 A4 A5

50 µL

A6

MIX

50 µL 50 µL

B3 B4 B5

50 µL

B6

50 µL 50 µL

B1 B2

MIX
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ADDING THE ANTIGENS TO THE ELISA PLATES

9.	 OBTAIN two microtiter ELISA plates and tubes of Unknown 1 and Unknown 2. Each plate contains 3 columns and 
8 rows of wells. 

10.	 Using a fine-tipped marker, LABEL the left column of each plate as “1”, the center column as “2”, and the right 
column as “3”. Finally, DRAW a line between rows 6 and 7 on both plates.  You will only use the wells on the 
top section of each plate.

11.	 With a fresh pipette tip, TRANSFER 50 µL from tube A1 into the top left well of EACH plate (column 1, row 1).
12.	 With a fresh pipette tip, TRANSFER 50 µL from tube A2 into the well directly below the sample from step 11 

(column 1, row 2).
13.	 Continue to TRANSFER 50 µL of the remaining Antigen A samples in the appropriate wells of column 1 on both 

plates.
14.	 With a fresh pipette tip, TRANSFER 50 µL from tube B1 into the top center well of EACH plate (column 2, row 1).
15.	 With a fresh pipette tip, TRANSFER 50 µL from tube B2 into the well directly below the sample from step 14 

(column 2, row 2).
16.	 Continue to ADD 50 µL of the remaining Antigen B samples in the appropriate wells of column 2 on both plates.

9. 10.
1 2 3

11.
1 2 3

12.

13.

1 2 3

CONTINUE 
THRU A6 for 
both plates.

14. 15.

1 2 3

16.

1 2 3

CONTINUE
THRU B6 for
both plates.

1 2 3

1 2 3

17.

20.

1 2 3

U1

50 µL 50 µL

1 2 3

18.
1 2 3

U2

50 µL 50 µL

1 2 3

19.
1 2 3

5
min.

INCUBATE

U1

U2

22. 23.21.
1 2 31 2 3

INVERT &
TAP

WASH INVERT &
TAP

REPEAT WASH,
INVERT & TAP

1 2 31 2 3

B1

50 µL 50 µL

1 2 31 2 3

B2

50 µL 50 µL

1 2 3 2 31 2 3

A1

50 µL 50 µL

11 2 3

A2

50 µL 50 µL

Module I: Performing a Quantitative ELISA, continued
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17.	 With a fresh pipette tip, TRANSFER 50 µL from tube U1 into the top three wells of the right column of EACH 
plate (column 3, rows 1-3).

18.	 With a fresh pipette tip, TRANSFER 50 µL from tube U2 into the next three wells of the right column of EACH 
plate (column 3, rows 4-6).

19.	 INCUBATE both plates for 5 minutes at room temperature.

REMOVAL OF SAMPLES AND WASHING THE WELLS

20.	 INVERT the plates over the sink or a stack of paper towels to remove the samples. Gently TAP the plates 4-5 
times onto a fresh paper towel. DISCARD the wet paper towels.

21.	 Using a transfer pipette, ADD Wash Buffer to fill each well, being careful not to overfill. 

NOTE: To minimize cross-contamination it is important that you avoid spilling buffer into neighboring wells. 

22.	 REPEAT step 20 to REMOVE the Wash Buffer.
23.	 Using the same transfer pipette, REPEAT the wash a second time. INVERT the strips onto fresh paper towels 

and TAP.

9. 10.
1 2 3

11.
1 2 3

12.

13.

1 2 3

CONTINUE 
THRU A6 for 
both plates.

14. 15.

1 2 3

16.

1 2 3

CONTINUE
THRU B6 for
both plates.

1 2 3

1 2 3

17.

20.

1 2 3

U1

50 µL 50 µL

1 2 3

18.
1 2 3

U2

50 µL 50 µL

1 2 3

19.
1 2 3

5
min.

INCUBATE

U1

U2

22. 23.21.
1 2 31 2 3

INVERT &
TAP

WASH INVERT &
TAP

REPEAT WASH,
INVERT & TAP

1 2 31 2 3

B1

50 µL 50 µL

1 2 31 2 3

B2

50 µL 50 µL

1 2 3 2 31 2 3

A1

50 µL 50 µL

11 2 3

A2

50 µL 50 µL

Module I: Performing a Quantitative ELISA, continued
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ADDITION OF PRIMARY AND SECONDARY ANTIBODIES

24.	 Using a fine-tipped marker, LABEL one plate with "A" and the other with "B".
25.	 Using a new micropipette tip, ADD 50 µL of Primary Antibody A (AbA) to each sample well on plate A.
26.	 Using a new micropipette tip, ADD 50 µL of Primary Antibody B (AbB) to each sample well on plate B.
27.	 INCUBATE for 5 minutes at room temperature.
28.	 INVERT onto paper towels and TAP. WASH the wells twice as in steps 20-23.
29.	 Using a new micropipette tip, ADD 50 µL of the Secondary Antibody (2°AB) to each sample well on BOTH 

plates.
30.	 INCUBATE for 5 minutes at room temperature.
31.	 INVERT onto paper towels and TAP. WASH the wells twice as in steps 20-23.

Module I: Performing a Quantitative ELISA, continued

25.
A 1 2 3

50 µL

Primary
Antibody

A

26. 28. INVERT, TAP
and WASH 2X.

31. INVERT, TAP
and WASH 2X.

1 2 3

50 µL

Primary
Antibody

B

B

29.
A 1 2 3

50 µL

Secondary
Antibody

1 2 3

50 µL

B

32.

A 1 2 3

50 µL

ABTS
SUBSTRATE

1 2 3

50 µL

B

34.

A 1 2 3

50 µL

STOP
SOLUTION

1 2 3

50 µL

B

1 2 3B

27.
A 1 2 3

min.

INCUBATE

30. INCUBATE

1 2 3B

33.
A 1 2 3

2-5
min.

INCUBATE

24.
1 2 3 1 2 3A B

5

1 2 3BA 1 2 3

min.
5
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Module I: Performing a Quantitative ELISA, continued

25.
A 1 2 3

50 µL

Primary
Antibody

A

26. 28. INVERT, TAP
and WASH 2X.

31. INVERT, TAP
and WASH 2X.

1 2 3

50 µL

Primary
Antibody

B

B

29.
A 1 2 3

50 µL

Secondary
Antibody

1 2 3

50 µL

B

32.

A 1 2 3

50 µL

ABTS
SUBSTRATE

1 2 3

50 µL

B

34.

A 1 2 3

50 µL

STOP
SOLUTION

1 2 3

50 µL

B

1 2 3B

27.
A 1 2 3

min.

INCUBATE

30. INCUBATE

1 2 3B

33.
A 1 2 3

2-5
min.

INCUBATE

24.
1 2 3 1 2 3A B

5

1 2 3BA 1 2 3

min.
5

ADDITION OF SUBSTRATE

32.	 Using a new micropipette tip, ADD 50 µL of ABTS substrate to each sample well on BOTH plates. 
33.	 INCUBATE the plate for 2-5 minutes at room temperature, or until color no longer changes in the wells with 

the highest antigen concentrations.  NOTE: It is important that the reaction is not allowed to proceed for 
more than 10 minutes as the enzymatic reaction can saturate at the highest concentrations of substrate.

34.	 Using a new micropipette tip, ADD 50 µL of Stop Solution to each sample well on BOTH plates. Gently TAP 
plates to MIX.

35.	 DOCUMENT results by using a digital camera to take a picture.  Placing the plates on a white sheet of paper or 
white light box can increase contrast between wells.

36.	 PROCEED immediately to Module II: Analysis of Quantitative ELISA.
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Module II-A: Analysis of Quantitative ELISA

1.	 OBSERVE the color of the reactions in your standard curves on both plates. There should be a strong green 
substrate in the most concentrated wells that gradually fades in the wells that received more diluted samples 
(as you move down a column). 

2.	 CONFIRM that the antibodies were only able to detect their specific antigens - Antibody A should only detect 
Antigen A – by examining column 2 in plate A and column 1 in plate B. 

3.	 Using the standard curves, ESTIMATE the concentration of Antigens A and B in the two Unknown samples. 
Record your results in Table 3 on page 22.

QUANTITATIVE ELISAEDVO-Kit 278
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Module II-B: Quantitative Analysis

The color intensity of each well can be determined using densitometry, the quantitative measurement of light ab-
sorption. In this ELISA the initial concentration of antigen determines how many molecules of ABTS are oxidized. 
Oxidized ATBS turns the solution green, which leads to more light absorption. Therefore, by measuring the sample 
color intensity in the standard curve wells of known concentration, we can establish a relationship between 
antigen concentration and light absorption.  This relationship is described by the equation of the standard curve. 
Using the equation we can then estimate the original concentration of antigen in the unknown sample.  

1.	 Calculate the mean gray value and the protein concentration for the standard curve wells of each antigen.  
	 a.	 SAVE the digital image of your results as a JPEG on the computer. 
	 b.	 OPEN the ImageJ program on your computer.
	 c.	 Go to File > Open and open your image. 
	 d.	 Go to Image > Type > 32 bit. 
	 e.	 Go to Edit > Invert. 
	 f.	 Go to Analyze > Set Measurements and select “mean gray value”. 

NOTE: In digital images each pixel has a luminance – or light intensity – value which ranges from black (zero 
intensity) to white (full intensity). In Image J this value is called gray value. The mean gray value is calcu-
lated by adding all the gray values in a selection and then dividing by the total number of pixels. 

	 g.	 CHOOSE the round selection tool and 
draw a circle around the first well. 

	 h.	 Go to Analyze > Measure. A new 
window titled results should appear. 
RECORD the results for “mean gray 
value” in your lab notebook or in the 
table below.

	 i.	 Click back to the digital image of 
your results and use the mouse 
or arrow keys to MOVE the circle 
to next well. REPEAT step h for all 
remaining wells on both plates.  

	 j.	 COMPLETE Tables 1 and 2 (at right) 
using the mean gray values and the 
antigen concentrations from Table 3 
on page 22. 

OPTIONAL: If a spectrophotometer is avail-
able, the absorbance of ABTS can be mea-
sured at 420 nm. Transfer the samples to 
the appropriate plate or cuvette and mea-
sure the absorbance of the standard curve 
and Unknown samples. The standard curve 
can then be used to accurately measure the 
concentration of antigens in the Unknown 
samples.

Table 1: Calculations for the Standard Curve of Antigen A

 
Well Dilution

 Mean Gray Antigen A
   Value Concentration
 1 1:1  8 µg/mL
 2 1:4
 3 1:16
 4 1:64
 5 1:256
 6 1:1024 

Table 2: Calculations for the Standard Curve of Antigen B

 
Well Dilution

 Mean Gray Antigen B
   Value Concentration
 1 1:1  8 µg/mL
 2 1:4
 3 1:16
 4 1:64
 5 1:256
 6 1:1024 

NOTE:
Detailed download instructions 

for ImageJ can be found at:
http://rsb.info.nih.gov/ij/download.html

QUANTITATIVE ELISA EDVO-Kit 278
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Module II-B: Quantitative Analysis, continued

2.	 Create a standard curve.
	 a.	 PLOT the antigen concentra-

tion (x axis) against the mean 
gray value (y axis) for each 
standard concentration for 
Antigen A. 

	 b.	 DRAW a best-fit curve through 
the points in the graph (for 
best results we suggest using 
graphing software). Record 
the equation for your curve 
for use later.

	 c.	 REPEAT Steps 2a and 2b for 
Antigen B.

NOTE:  The best-fit line may not pass 
through every data point.

3.	 Determine the concentration of 
target protein in the unknown 
samples. 

	 a.	 Find the mean gray values of 
the sample in the unknown wells as in step 1. 

	 b.	 Determine the average gray value for each unknown sample. 
	 c.	 From the Y-axis of the standard curve graph, extend a horizontal line from this absorbance value to the 

standard curve. At the point of 
intersection extend a vertical 
line to the X-axis and read the 
corresponding concentration. 
Alternatively use the equation 
of the best-fit curve to solve 
for x given the y value (see 
Figure 4). You will have to do 
this twice for each unknown - 
once for antigen A and again 
for antigen B.

Based on your calculations, what is the 
concentration of each antigen in the 
unknown samples?

Figure 3:  Plotting a Standard Curve.
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Figure 4:  Determining a Protein Concentration.
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Study Questions

1.	 Describe an ELISA experiment beginning with the addition of antigen samples to the well and ending with the 
substrate color change reaction.

2.	 Why is it important to wash all of the wells between the addition of the components during the ELISA?

3.	 What can happen if the substrate is allowed to react for more than 10 minutes without adding the stop solu-
tion?

4.	 Why was it important to test Antibody A with Antigen B, and Antibody B with Antigen A?

QUANTITATIVE ELISA EDVO-Kit 278
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Instructor's Guide

OVERVIEW OF INSTRUCTOR’S PRELAB PREPARATION:

It is necessary to prepare the antigens, antibodies, and buffers prior to performing the experiment. All components 
should be kept at 4° C in the dark until needed. A student worksheet has been provided (page 22) to help students 
collect the necessary reagents and perform the experiment.

MODULE I: PERFORMING A QUANTITATIVE ELISA

Preparing the Microtiter Plate:

1.	 As shown in the figure below, orient the microtiter plate so that the numbers 1-12 are at the top and the letters 
A-H are on the left.

2.	 Divide each plate on the dotted lines as shown in the figure. Each piece will contain 3 wells on one axis and 8 
wells on the other axis. Each lab group will receive two pieces.

A

B

C

D

E

F

G

H

1 2 3 4 5 6 7 8 9 10 11 12

Row 1

Row 2

Row 3

Row 4

Row 5

Row 6

Row 7

Row 8

Cutting lines depicted by dashed lines

Module I: Performing a
Quantitative ELISA

Divide microtiter plates Before the class period 5 min.

Prepare secondary 
antibody

Same day as the lab 10 min.

Prepare and Aliquot
Reagents

Up to 1 week before the lab 30 min.

Preparation for: What to do: When: Time Required:

NOTE: This experiment is intended to be run over the course of a single lab period and should take approximately 
45-60 minutes. If necessary, the experiment can be stopped after the first wash, step 23 on page 10 . Instruct 
the students to add wash buffer to each well on their plates, carefully cover with plastic wrap or place into a 
plastic bag to prevent evaporation, and store the plates overnight at 4˚C. We do not recommend storing the 
plates for longer than 24 hours before continuing the experiment.
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Pre-Lab Preparations - On The Day Of The Lab 

Preparation of Antigen

The antigens used in this experiment are supplied as lyophilized proteins and must be rehydrated before use. Fol-
low the directions below to prepare Antigens A and B as 8 µg/ml stocks. These will be used for students to create 
standard curves, as well as for the unknown samples.

1.	 Dispense 1.6 mL of the Dilution Buffer (Component C) into 10 microcentrifuge tubes and label as “Dilution 
Buffer”. Reserve the remaining buffer for preparation of the antigen samples.

2.	 Transfer 5 mL of Dilution Buffer (Component C) into a 15 mL conical tube. Label the tube “A1”. 
3.	 Transfer approximately 0.5 mL of the Dilution Buffer from step 2 into the tube of Antigen A (Component A). 

Pipette up and down or vortex to mix.
4.	 Transfer the entire contents of the reconstituted Antigen A back to the 15 mL tube from step 2. Mix well.
5.	 Dispense 180 µL of reconstituted Antigen A into ten 0.5 mL snap-top microcentrifuge tubes. Label the tubes as 

“A1”. Save the remaining Antigen A for the Unknown Samples.
6.	 Using a fresh 15 mL conical tube, repeat steps 2-4 for Antigen B (Component B).
7.	 Dispense 180 µL of reconstituted Antigen B into ten 0.5 mL snap-top microcentrifuge tubes. Label the tubes as 

“B1”. Save the remaining Antigen B for the Unknown Samples.
 
Preparation of Unknown Samples

1.	 Label one 5 mL tube as “Un1” and a second tube as “Un2” and prepare the unknown samples using the dilu-
tion buffer and rehydrated antigens from the previous section.

2.	 Dispense 360 µL of Unknown 1 into ten 0.5 mL microcentrifuge tubes. Label the tubes as “U1”.
3.	 Dispense 360 µL of Unknown 2 into ten 0.5 mL microcentrifuge tubes. Label the tubes as “U2”.

Preparation of the Primary Antibodies 

1.	 Transfer 12 mL of Dilution Buffer (Component C) into a 15 mL conical tube. Label the tube “AntiA”.
2.	 Carefully remove the stopper from the vial of Primary Antibody A (Component D) and transfer approximately 

0.5 mL of the Dilution Buffer from step 1. Close the stopper and gently shake the glass vial to mix.
3.	 Transfer the entire contents of reconstituted Primary Antibody back to the 15 mL tube from step 1. Mix well.
4.	 Dispense 1.1 mL of Primary Antibody A into 10 microcentrifuge tubes. Label the tubes as “AbA” or "1°A".
5.	 Repeat steps 1-3 for Antibody B (Component E) using a fresh 15 mL conical tube.
6.	 Dispense 1.1 mL of Primary Antibody B into 10 microcentrifuge tubes. Label the tubes as “AbB” or "1°B".

Preparation of 1x Wash Buffer

1.	 Add contents of the 10x Wash Buffer (Component F) to 540 mL of distilled water. Mix well.
2.	 Dispense 55 mL of the diluted wash buffer into a small beaker for each group. Label the beakers “Wash buf-

fer”. Save the remaining Wash buffer for rehydrating the Secondary Antibody.

Sample	 Dilution Buffer	 Antigen A	 Antigen B

Unknown 1	 2600 µL	 1300 µL	 50 µL

Unknown 2	 3400 µL	 20 µL	 580 µL

1.800.EDVOTEK •  Fax 202.370.1501  •  info@edvotek.com  •  www.edvotek.com
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Pre-Lab Preparations - During the Lab Experiment

Each Lab Student Group Should Receive:

	 10 	 Empty 0.5 mL Microcentrifuge tubes 
	 2 	 Microtiter plates (3x8 well) 
	 1 	 Microcentrifuge tube containing 1.6 mL Dilution Buffer 
	 1 	 Microcentrifuge tube containing 180 µL Antigen A (A1)
	 1 	 Microcentrifuge tube containing 180 µL Antigen B (B1)
	 1 	 Microcentrifuge tube containing 360 µL Unknown 1 (U1)
	 1 	 Microcentrifuge tube containing 360 µL Unknown 2 (U2)
	 1 	 Microcentrifuge tube containing 1.1 mL Antibody A (AbA)
	 1 	 Microcentrifuge tube containing 1.1 mL Antibody B (AbB)
	 1 	 Microcentrifuge tube containing 1.9 mL Secondary Antibody (2˚AB)
	 1 	 Microcentrifuge tube containing 1.9 mL Substrate (ABTS)
	 1 	 Microcentrifuge tube containing 1.9 mL Stop Solution (Stop)
	 1 	 Transfer pipet
	 1 	 Beaker containing 55 mL 1X PBST Wash Buffer
	 •	 Paper towels

Dilution of the Secondary Antibody
(Prepare on the same day as needed for the experiments.)

NOTE: You must use DILUTED WASH BUFFER to prepare the secondary antibody.

1.	 Transfer 19 mL of diluted Wash buffer to a 50 mL conical tube. Label the tube “2°AB”.
2.	 Carefully remove the stopper from the vial of Secondary Antibody (Component G) and transfer approximately 

0.5 mL of the Wash buffer from the tube in step 1. Close the stopper and gently shake the glass vial to mix.
3.	 Transfer the entire contents of reconstituted Secondary Antibody back to the 50 mL tube from step 1. Mix well.
4.	 Label 10 microcentrifuge tubes "2°AB" and dispense 1.9 mL per tube. 

Preparation of ABTS Substrate and Stop Solution

1. Dispense 1.9 mL of ABTS (Component H) into 10 microcentrifuge tubes. Label the tubes as “ABTS”.
2. Dispense 1.9 mL of Stop Solution (Component I) into 10 microcentrifuge tubes. Label the tubes as “Stop”.

NOTE: Stop Solution can precipitate when stored at 4° C. If precipitate is seen, gently warm the solution to 
resuspend before aliquoting.
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A representative ELISA can be seen below. The intensity 
of the reactions will vary slightly due to differences in 
incubation times and the temperature of reagents, but 
the results should be similar.

Unknown samples should be compared to the standard 
curves to determine the concentration of antigen in each 
sample. 

Avoiding Common Pitfalls

1. 	 Students should be advised to be very careful when transferring solutions into and out of the microtiter plate 
wells.

2. 	 Use only clean or appropriately labeled pipets.

3. 	 Wash the wells gently and slowly, without force.

Experiment Results and Analysis
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Please refer to the kit 
insert for the Answers to 

Study Questions



Student Worksheet

Each Student Group should receive:	 Check (√ )	
10	 Empty 0.5 mL Microcentrifuge tubes 	 q
1	 Microtiter plates (3x8 well) 	 q
1 	 Microcentrifuge tube containing 1.6 mL Dilution Buffer 	 q
1 	 Microcentrifuge tube containing 180 µL Antigen A (A1)	 q	
1 	 Microcentrifuge tube containing 180 µL Antigen B (B1)	 q	
1 	 Microcentrifuge tube containing 360 µL Unknown 1 (U1)	 q
1 	 Microcentrifuge tube containing 360 µL Unknown 2 (U2)	 q
1 	 Microcentrifuge tube containing 1.1 mL Antibody A (AbA)	 q	
1 	 Microcentrifuge tube containing 1.1 mL Antibody B (AbB)	 q	
1 	 Microcentrifuge tube containing 1.9 mL Secondary Antibody (2˚AB) 	 q	
1 	 Microcentrifuge tube containing 1.9 mL Substrate 2 (ABTS) 	 q	
1 	 Microcentrifuge tube containing 1.9 mL Stop Solution (Stop)	 q	
1 	 Transfer pipet	 q	
1 	 Beaker containing 55 mL 1X Wash Buffer	 q	
•	 Paper towels 	 q

Row 1

Row 2

Row 3

Row 4

Row 5

Row 6

Dilution Concentration Dilution Concentration

Table 3:  Dilutions and Concentrations of Standard Curves

Antigen A Standard Curve Antigen B Standard Curve

----

1:4

----

1:4

8 µg/mL 8 µg/mL

			        UNKNOWN 1					          UNKNOWN 2

Antigen A:_____________________________      Antigen A:_____________________________

Antigen B:_____________________________      Antigen B:_____________________________
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